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CREATING COMPANY RECORDS  
& GROUPING CONTACTS 

  
  

 
 

In this lesson you will learn the following company record and 
group techniques: 
 

 Creating company and division records 
 Associating and linking contacts to companies 
 Duplicating company and division records 
 Using the Company Lookup command 
 Using Companies and Groups trees 
 Creating groups 
 Adding contacts to a group 
 Managing group notes and attachments 
 Saving the result of a lookup as a group or company 
 Creating subgroups 
 Converting a group to a company 
 Using the Convert Groups to Companies Wizard 
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Differences Between Companies And Groups 
In this lesson you will learn how to create company and group records. On the surface they may appear to be 
the same and have the same functionality, but there are some differences. Company records have more 
functionality than group records. To start with, company records have more fields which can be used to 
automatically fill in (link) fields on a contact record. The opposite is also true. Fields on a contact record can be 
used to fill in fields on a company record. Company and group records cannot have the same name. Creating a 
group is like saving a lookup. When you view the contacts from a company or group detail view you can see 
the notes, activities and opportunities for the contacts in the company or group on one tab. 
 

Company And Divisions Overview 
Company records allow contacts in the company to be managed easier. If a company has a lot of contacts,  
it may be easier to manage the contacts if divisions were created for the company. Brick and mortar companies 
have divisions, departments and business units. Companies in ACT! can have them also. You can create 
companies and divisions that best meet your needs. It is also possible that you may not need any companies or 
divisions. 
 
The COMPANY record type allows you to keep track of contacts in the same company. In a way, a company 
record is similar to a group. This may be why the groups and companies are on the same tab. You can see all 
of the companies and groups except dynamic groups that a contact is a member of. It would be nice if there 
was a way to know if the entries on this tab are a company or group. Contacts can be associated with more 
than one company. 
 
An example of when you would associate a contact to more than one company would be if one consultant did 
work for multiple companies that are in your database. You can create activities, notes and opportunities, as 
well as, attach documents to a company record. In ACT! any of the following are acceptable ways to categorize 
contacts in a company. I am sure that you can come up with several others. 
 
  Create divisions that are like the divisions in a brick and mortar company. 
  By title. 
  By contacts home state. 
  By ID/Status. 

 
In addition to being able to create 15 levels of divisions, you can also create SUBDIVISIONS. This type of 
category lets you further divide the contacts into groups that are easier to manage. An example of when it 
would be appropriate to create subdivisions would be for a company that has 1,000 sales reps. I would create 
a division called "Sales Reps". I would then create subdivisions for each of the product lines the company has 
like telephones, digital cameras, camcorders and televisions. Then I would add the reps to the appropriate 
subdivision(s) based on the product line(s) that the rep sells. As you can see, divisions and subdivisions allow 
you to organize contacts in the way that works best for you. 
 
A contact that is in a division does not have to also be part of the company. This means that you can add a 
contact to a division without being required to add it to the company. Divisions are independent of the 
company they are under. 
 

Company Toolbar 
Each view has its own toolbar. Many of the buttons on the toolbars are the same. Figure 3-1 shows the 
Company toolbar. Table 3-1 explains the buttons on the toolbar. 
 

 
 
Figure 3-1 Company toolbar 
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 Button  Description  
1 Opens the Company Detail view. 
2 Opens the Company List view. 
3 Saves the record. (1) 
4 Opens the Print dialog box. 
5 Opens a new company record. 
6 Opens a new division record. 
7 Add or remove a contact. 
8 Updates the linked contacts for the selected company. 
9 Add a note for the company record. 
10 Schedule a telephone call. 
11 Schedule a meeting. 
12 Schedule a To-Do. 
13 Create a new opportunity. (1) 
14 Attach a file to a company record. 
15 Creates a contact lookup for the company. 
16 Compose and send an email. 
17 Exports the company list to Excel. (2)  
18 Opens the Help system. 

 
Table 3-1 Company toolbar buttons explained 
 

 (1) This option is only available from the Company Detail view. 
 (2) This option is only available from the Company List view. 

 

The Companies Tree 
This tree displays all of the companies, divisions and 
subdivisions in the database as shown in Figure 3-2.  
 
The Companies tree is on the left of the Company Detail 
view. At the top of the Companies tree, the number of 
companies and divisions in the database are displayed. 
 
A plus sign in front of a company means that there is at 
least one company or division below it. If you click on a 
company in the tree, you will see the detail information 
for the company on the right side of the window. 
 

 
 
Figure 3-2 Companies tree 
 

You can use the tree to complete several tasks including 
moving, creating and deleting a company. Any task that 
you can do for a company, you can also do for a division 
or subdivision. Like other features in ACT!, the 
Companies tree has a shortcut menu as shown in  
Figure 3-3. 
 
Company records in the Companies tree may or may not 
contain the same companies that you see in the Contacts 
view. For example, in the Contact List view you will see 
the following companies, Cadbury, County Tennis 
Supplies and Liberty. If you look in the Companies tree, 
you will not see an entry for these companies. It is not a 
requirement that every company have a company record. 

 
 
Figure 3-3 Companies tree shortcut menu 
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The Company List view displays all of the companies in the database. Like the Contact List view, you can sort 
on the column headings in the Company List view. If there are a lot of companies in the list you may have a 
need to filter them. 
 

Create New Contact Records 
To complete some of the company exercises, you need to add new contact records to the database. 
 

1. Create contact records for the following names. You only have to enter the name. 
John Doe, Jennifer Doe, Charles Smith, Mary Wood, Bill Grant.  
 

2. Create contact records for the following names: Laura Smith and Tom Wood. Type Lookup in the 
Company field for these two records. They will be used later in this lesson to lookup contacts and link 
them to a company. 
 

Exercise 3.1: Create A Company Record 
1. Click the COMPANIES button on the Navigation bar. 

 
2. Click the NEW COMPANY button on the toolbar, then create records for the two companies in Table 3-2. 

The first record should look like the one shown in Figure 3-4. 
  

Field  Company #1 Company #2 
Company  My Company My Other Company 
Address 123 Main St 456 South St 
City  Hitsville Hollywood 
State  CA CA 

 
Table 3-2 Company record data 
 

 The HIERARCHY 
field will 
automatically fill 
in. 

 
 
Figure 3-4 New company record 
 

ACT! prevents you from creating duplicate 
company records. If you enter a company 
name that already exists, you will see the 
warning message shown in Figure 3-5.  
This gives you the option of linking to the 
company record that already exists.  
 

 
Figure 3-5 Duplicate company warning message 
 

Exercise 3.2: Create Divisions For A Company 
Creating a division uses the same screen as a company record. 
 

1. Display the company record that you want to create a division for. For this exercise click on the company 
My Company, in the Companies tree. 
 

2. Click the NEW DIVISION button on the toolbar. 
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3. Type the division name in the Company field. For this exercise type Finance in the Company field. 
 

4. Create the divisions in Table 3-3 under the correct company. 
  

Division   Company 
Technology Division My Company 
Marketing  My Other Company 
Sales Division My Other Company 

 
Table 3-3 Divisions to create 
 

Associating Contacts To Companies And Divisions 
Contacts can exist in an ACT! database without being linked to a company. Companies can be in an ACT! 
database without having contacts linked to them. There is no requirement that contacts and companies be 
linked, so don't be alarmed if you have contact records that are not linked to company records or vise versa. 
Although, I'm not sure why someone would create a company and not associate any contacts to it, but it is 
acceptable in ACT!. There are two ways to associate contacts to companies as discussed below. 
 
  Manually  This method entails creating the link between a contact and a company. ACT! refers to 

this type of link as a STATIC link. That is because the link will remain intact until you manually change 
it. 

  Automatically  This method entails creating a query that selects the contact records that will be 
linked to a company. ACT! refers to this type of a link as a DYNAMIC link. This is because the contacts 
associated to a company will change automatically, depending on whether or not the data in the 
contact record meets the criteria in the query. A contact record can meet the criteria in the query this 
week and not meet the criteria next week if the data in any of the fields that the query uses, 
changes. You will learn how to create this type of query in Lesson 8.  
 

Exercise 3.3: Associate A Contact From A Company Record 
There are several ways to associate contacts with a company. In this exercise you will learn different ways to 
accomplish this task. Contact records can be associated to companies from the contact record. The opposite is 
also true. Contact records can be associated to companies from the company record.  
 

1. Open the company record for My Other Company in the Company Detail view. On the far right of the 
view you should see the two divisions that you created. 
 

2. Click the Add/Remove Contacts button on the toolbar or the same button below the tabs. 
 

3. Click the CONTACTS button, then type Doe in the Look for field. Select the contact record for John Doe.  
 

4. Click the Add button, then click OK. The contact should be in the STATIC MEMBERS section of the dialog 
box as shown in Figure 3-6. Click OK. You will see the contact on the Contacts tab in the Company Detail 
record. 
 

 

 
 
Figure 3-6 Add/Remove Contacts dialog box 
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Other Ways To Open The Add/Remove Contacts Dialog Box  
 
From A Company View 

 Companies ⇒ Company Membership ⇒ Add/Remove Contacts. 
 Right-click on the company name in the Companies tree and select  

Company Membership ⇒ Add/Remove Contacts. 
 On the Contacts tab, right-click and select Company Membership ⇒ Add/Remove Contacts. 

 
From A Contact View 

 Companies ⇒ Company Membership ⇒ Add Selected to Company. You will see the dialog box shown 
in Figure 3-7. 

 On the Groups/Companies tab, select Companies and Divisions from the SHOW MEMBERSHIP FOR  
drop-down list, then click the Add Contact to Company button, as shown in Figure 3-8. 

 On the Contact List view, right-click and select Add Contacts to Company. You will see the dialog box 
shown in Figure 3-7. 
 

 
 

The entries in the IS A MEMBER OF 
list are companies, divisions and 
subdivisions that the contact is a 
member of. I find this dialog box 
helpful because you can add and 
remove companies and divisions 
for the contact at the same time. 

 
 
Figure 3-7 Add Contact to Groups/Companies dialog box 
 

 
 
Figure 3-8 Company options on the Contact Detail view 
 

Exercise 3.4: Create A Company Record From A Contact Record 
Earlier you created a company record from scratch. Creating a company record from a contact record that has 
the address information for the company will keep you from having to type it in again. You can create a 
company record from a contact record by following the steps below. 
 

1. Select the contact that has the information for the company record that you want to create.  
In this exercise select the contact Jane Bellamy of Boomers Artworx. 
 

2. Companies ⇒ Create Company from Contact. The Company Detail view will open and the company name 
and address fields will automatically be filled in. 
 

Exercise 3.5: Create A Contact Record From A Company Record 
Creating a contact record from a company record that has the address information will keep you from having 
to type it in. You can create a contact record from a company record by following the steps below. 
 

1. Select the company on the Companies tree that has the information for the contact record that you want 
to create. In this exercise select the company Circle Photography. 
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2. Companies ⇒ Create Contact from Company. The Contact Detail view will open and the company name 
and address fields will automatically be filled in. Type Test Record in the Contact field and move to 
another record. 
 

Refreshing Linked Data In Contact Records 
It is possible that you may not be viewing the most current data. This happens when there are several people 
using the database. To make sure that you are viewing the most current data, refresh the data of the contact 
record that is displayed in the Contact Detail view. Contacts ⇒ Update Linked Contact. 
 

Linking Company And Contact Records 
If you scroll through the contact records you will see that some company names are blue and underlined and 
others are not. The company names that are blue and underlined are linked. You can click on this link and 
open the company or division record. 
 
Fields on the contact record that are linked will automatically be updated when the corresponding field in the 
company record is updated. This means that if the company name field on the company record changes from 
DEF Company to HIJ Company, any contact records that are linked to that company record on the company 
name field will automatically be updated if the AUTOMATICALLY LINK NEW CONTACTS TO THEIR COMPANY RECORD 
option as shown in Figure 3-9, is checked.  
 
Tools ⇒ Preferences ⇒ Startup tab ⇒ Company Preferences button, will open the Company Preferences dialog 
box shown in Figure 3-9. The button at the end of the Company field on a contact record that is not already 
linked, opens the dialog box shown in Figure 3-10. If the contacts company name already exists in the 
database, you can link the contact to the company by selecting the company name on the dialog box. 
 

 
 
Figure 3-9 Company Preferences dialog box 
 
 

 
 
Figure 3-10 Link To Company dialog box 
 

Associate vs Linking 
On the surface these terms sound like they perform the same function. Understanding the difference is only 
important if you have the need to make some contacts private. In ACT!, associating and linking have different 
functionality as discussed below. I'm not sure if how the "Private" option works is how it was intended to work, 
but I find it somewhat deceiving. 
 
In "My world", when you mark a contact as private, whether or not the contact is "linked" to a company,  
any information that you enter on any of the tabs is also marked as private by default. The exception would  
be if you manually override the private option for a specific piece of information. If a history record is created 
when information about the contact is added, changed or deleted, the history record should also be 
automatically marked as private. Well, I started this paragraph off by saying in "My world". 
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The scenario that I just described is NOT how the private option works in ACT! if the contact record is "linked" 
to a company record. When a note or history record is created for a contact that is linked to a company record, 
they are visible from the company record by default. If this is not what you want to happen, mark the note  
as private on the Insert Note dialog box. 
 

 
 

 
Linking Issues 
 
Overall, linking contacts to companies is a good feature to have and use. Depending on how sensitive 
some of the contact data is, you may not want it to be shared. Some contact data is automatically 
shared. I think that it is important that you understand how linking works. 
 
By default, contact notes, history, activity and opportunity records are displayed under the company 
record(s) that they are linked to. I thought that if the association (link) between a contact and company 
was removed that the contacts history, activity and opportunity records would also be removed from the 
company record, but that is not the case. I can understand why they are not automatically removed 
because the primary purpose of company records is to build a profile of the company, which includes the 
interactions with all of the contacts associated with the company. I just wanted to let you know that the 
contact linked data is not automatically removed from the company record when the records are 
unlinked. 
 
Solutions 
There are ways to prevent notes and history records from being displayed under the company record. 

 As you already learned, when you create a note you can mark it as PRIVATE. 
 If you know that you do not want any contact note and history records to be displayed under 

company records, clear the SHARE NEW NOTES AND HISTORIES ON LINKED CONTACTS. . . option shown 
earlier in Figure 3-9. With this option cleared (not checked) you can share a specific note if you have the 
need to do so. 
 

Depending on a users rights, they may not be able to see all of the contact information that is displayed under 
the company record. Users that have rights to the contact record will be able to view the activity and 
opportunity records that are displayed under the company record. 
 

 

 
Contacts can be associated to multiple companies and divisions but can only be linked to one company. 
  

Exercise 3.6: Creating Manual Links Between Contacts And Companies 
In this exercise you will learn several ways to link contact and company records. 
 

Manually Link A New Contact With A Company  
In this part of the exercise you will create the contact record and then link it to a company.  
 

1. Open a new contact record and enter the name Jane Doe. 
 

2. Click the button next to the Company field, then select the company, My Company and click OK.  
You will see that the company name is a link.  
 

3. Click the Save button. If you click on the company link, you will see the company record on the  
Company Detail view. 
 

Manually Link An Existing Contact With A Company  
In this part of the exercise you will learn how to link an existing contact to a company. 
 

1. Right-click in the Contact field in the Contact Detail view and select LOOKUP CONTACT. 
 

2. Type Charles Smith in the Contact field and press Enter. 
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3. Click the button next to the Company field, then select the company, My Company and click OK. 
 

 

 
You can link a contact to a division the same way that you linked a contact to a company in both parts of 
this exercise. Instead of selecting the company, select the division. 
 

Exercise 3.7: Lookup And Link Multiple Contact Records To A Company Record 
This type of linking is another example of the static link that you learned about earlier. 
 

1. Create a lookup that retrieves records that have LOOKUP in the Company field. 
 

2. Select (highlight) both records in the Contact List view, then Companies ⇒ Link to Company. 
 

3. Select the company, My Other Company and click OK. Click Yes when prompted to replace the company 
link. Click OK when prompted that no more records match the search criteria. 
 

This message is letting you know that the company name will be replaced, which is what you want. This is one 
way that you can change the company that several contacts are linked to at the same time. 
 
If you look at the My Other Company record on the Company Detail view, you will see that both contacts 
(Laura Smith and Tom Wood) have the new company name. Their old company name was "Lookup". 
 

Exercise 3.8: Understanding The Power Of Linking 
In the previous exercise you linked two 
contact records to a company record. 
Figure 3-11 shows the company and 
contacts associated with it. Notice that 
the Company field for John Doe is blank. 
This is how you can visually tell which 
contacts are linked to a company and 
which ones are not. In this exercise you 
will rename the company and observe the 
changes. 
 

 
Figure 3-11 Contacts associated with a company 
 

1. Open the My Other Company record in the Company Detail view. 
 

2. Change the Company name to My New Company. 
 

3. View ⇒ Refresh. This will update the company name throughout the database.  
 

Linking And Unlinking Contact And Company Fields 
You have learned that you could link the company name field on the contact record to the company name field 
in the company record. This is also true for other fields on the contact record. 
 

 
 

 
If you created a linked company record field it is applied to all company records, not just a particular 
record. The same is true if you unlink a company record field. 
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Viewing Linked Fields 
If you want to know how company fields are 
linked to contact fields,  
Companies ⇒ View Linked Fields.  
You will see the dialog box shown in  
Figure 3-12. 
 
The DEFINE FIELDS button will let you create, 
edit or delete fields. You will learn more about 
this option in the next exercise. 
 

 
 
Figure 3-12 View Linked Fields dialog box 
 

Exercise 3.9: Create A Linked Billing Address Field 
In this exercise you will change the Billing Address 1 field in the company record so that it is linked to the  
User 5 field. This is not a link that you would create in a live database because it really does not make a lot of 
sense. The fields that are normally linked between contact and company records are already linked in this 
database, as shown above in Figure 3-12. Therefore I had to select fields that were not linked. You will have to 
create linked fields in a database that you create from scratch. 
 

1. Tools ⇒ Define Fields. Open the VIEW FIELDS FOR drop-down list and select Companies. 
 

2. Click on the Billing Address 1 field. Click the EDIT FIELD link as illustrated in Figure 3-13, then click Next. 
 

 

 
 
Figure 3-13 Edit Field link illustrated 
 

3. On the Customize field behavior screen check the LINK TO CONTACT FIELD option, then open the  
drop-down list. Notice that some fields are dimmed out. You cannot select the dimmed out fields to link 
to because they have already been linked to a field. 
 

4. Select the User 5 field, then click Finish. In Figure 3-14, you will see that the Billing Address 1 field is 
linked to the User 5 contact field. Click Close. 
 

 

 
 
Figure 3-14 Billing Address 1 field linked to the User 5 contact field 
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Updating Contact Address Fields From The Linked Company Record 
If a company moves you would update the address fields on the company record. The next step is to update 
the contact records that are linked to the company record so that they display the updated address 
information. Before changing the company record, it is a good idea to view the linked contacts to make sure 
that they have the address that you are about to change. Companies can have several locations which means 
that there will be different addresses for the same company. You can create divisions under the company or 
create a different company for each location. The steps below will show you how to change the address on the 
company record and update the contact records. For now you can read the steps. 
 

1. Open the company record and change the address information, then save the changes. 
 

2. Click the UPDATES THE LINKED CONTACTS FOR THE CURRENT COMPANY button on the toolbar, then click YES 
when you see the message shown in Figure 3-15. 
 

 

 
 
Figure 3-15 Update linked contacts message 
 

Test The Linked Field That You Created 
To test the linked field, you will enter data in the Billing Address 1 field and observe how the linked contact 
records are updated.  
 

1. Select the company My New Company, then click on the Addresses tab. 
 

2. Type Test field link in the first billing address field. 
 

3. Click the Save button, then click the UPDATES THE LINKED CONTACTS FOR THE CURRENT COMPANY button on 
the toolbar. Click Yes when you see the message shown above in Figure 3-15.  
 

4. On the Contacts tab, click on one of the records that has the company name, My New Company.  
On the User Fields tab of the contact record, you should see the text that you entered in the company 
Billing Address 1 field in the User 5 field as shown in Figure 3-16. 
 

 

 
 
Figure 3-16 User fields 
 

User Fields Tab 
In the exercise that you just completed, you added data to a user field. If this was a live database you would 
rename the user field and update the layout. If you do not do this, other people that use the database will not 
know what type of data should be in the field. You will learn how to modify layouts in Lesson 10. 
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Unlink A Company Record Field 
If you have a field that is linked, but no longer need it to be linked, follow the steps below. You do not have to 
complete these steps now. 
 

1. Tools ⇒ Define Fields. 
 

2. Select the field that you want to unlink, then click the EDIT FIELD link.  
 

3. Click Next, then clear the LINK TO CONTACT FIELD option shown in Figure 3-17. 
 

 

 
 
Figure 3-17 Customize field behavior options 
 

4. Click Finish, then click Close. 
 

Previously linked fields that have data will keep the data even though the field is no longer linked. Based on 
the example above, this statement would refer to the contact records. Keep in mind that contact records can 
link to company records, which would update the company record when a contact record is changed. 
 

Adding Contacts To Divisions 
There are several ways to add contacts as discussed below. It would be easier if we could use a drop and drag 
feature to add or move a contact record from one company or division to another one.  
 
  Right-click on the division in the Companies tree and select COMPANY MEMBERSHIP ⇒  ADD REMOVE 

CONTACTS. You will see the Add/Remove Contacts dialog box shown earlier in Figure 3-6. 
  Right-click on the contact on the Company Detail view and select COMPANY MEMBERSHIP ⇒  ADD 

REMOVE CONTACTS. You will see the dialog box shown earlier in Figure 3-6. 
  Right-click on the contact on the Company Detail view and select COMPANY MEMBERSHIP ⇒ ADD 

SELECTED TO COMPANY. You will see the dialog box shown earlier in Figure 3-7. 
 

Exercise 3.10: Using The Companies Tree To Move A Division 
You can drag divisions from one company to another. You can also drag a company to another company and 
make it a division. 
 

1. Expand the two companies that you created earlier in this lesson by clicking on the plus sign in front  
of them. 
 

2. Drag the Finance division from the first company to the second company. The Companies tree should 
look like the one shown in Figure 3-18. 
 

 

 
 
Figure 3-18 Division moved from one company to another 
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3. Use the Companies tree to add the contacts in Table 3-4 to the appropriate division.  
  

Contact  Move From Move To  
Tom Wood My New Company Marketing 
Laura Smith My New Company Sales Division 
Jane Doe My Company Finance 
Charles Smith My Company Sales Division 

 
Table 3-4 Contacts to move 
 

Exercise 3.11: Duplicating Company And Division Records 
You can duplicate a company that has divisions, but the divisions are not duplicated. This is known as 
DUPLICATING a company. The process is similar to duplicating contacts that you learned to do in Lesson 2. 
 

1. In the Company Detail view, right-click on the company, My New Company and select Duplicate. 
  

2. On the dialog box shown in Figure 3-19 select the option, DUPLICATE DATA FROM ALL FIELDS and click OK. 
 

 

 
 
Figure 3-19 Duplicate Company dialog box  
 

3. You will see a company record that does not have a company name.  
Type My Duplicate Company in the Company field. 
 

4. View ⇒ Refresh. Click on the new company in the tree.  
 

Notice that there are no divisions and that the contact John Doe is a member. That is because this contact is 
not linked to the company, My New Company. If you click on the company record, My New Company, you will 
see the two other contacts shown earlier in Figure 3-11. They are linked to the company. 
 

Looking Up Companies 
Looking up companies is similar to looking up contacts. Lookup ⇒ Companies, will display the Lookup 
Companies dialog box, which is similar to the dialog box that you used in Lesson 2 to look up contacts.  
The differences are discussed below. 
 
  The Title bar on the dialog box has "Lookup Companies" instead of "Lookup Contacts". 
  The fields in the Look in this field drop-down list are company related fields. 
  Replace Lookup is the only lookup option. 

 

Exercise 3.12: Finding Companies 
It is really important to make sure that the company data is as accurate as possible. Often, when adding a new 
company or contact, you may not know all of the information that is important to you. From time to time it is a 
good idea to either lookup records that do not have data in certain fields or create reports that show records 
that are missing data. If your company does a variety of promotional campaigns, it may be important to track 
how each contact was obtained. You could use the Referred By field to store this information.  
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In this exercise you will find companies where the Referred By field is empty. 
 

1. Lookup ⇒ Companies ⇒ Other Fields. 
 

2. Open the Look in this field drop-down list and select Referred By, then select the EMPTY FIELD option. 
Click OK. 
 

The companies and divisions that you see in the Company List do not have the Referred By field filled in.  
Someone should try to fill in this information. 
 

Using The Company List View 
This view has the same shortcut menu as the Companies tree as shown earlier in Figure 3-2. 
 

Create A New Division 
To create a new division from the Company List View, right-click on the company that you want to create the 
division for and select NEW DIVISION. 
 

Create A Company Note 
Creating a note for a company is the same process and uses the same Insert Note dialog box that is used for 
creating notes for contacts. Right-click on the company that you want to create a note for and select  
INSERT COMPANY NOTE. The company name will automatically be filled in the Group/Company field on the 
Insert Note dialog box. 
 

Moving Companies And Divisions 
Earlier in this lesson you learned that you can drag companies and divisions to new locations. If you do not like 
to drag them, you can use the MOVE option on the shortcut menu shown earlier in Figure 3-3. The steps below 
explain the process. 
 

1. Right-click on the company or division that you want to move and select MOVE.  
 

 On the dialog box shown in Figure 3-20, select the 
PROMOTE DIVISION TO COMPANY option to make the 
division that you selected a company. 
 
Select the CHANGE TO BE DIVISION OF option if you want 
the company or division that you selected to be a division 
of another company. 

 
 
Figure 3-20 Move Division dialog box 
 

2. Select one of the options discussed above. 
 

3. If you selected the "Change to be division of" option, click on the company or division that you want to 
move it to, then click OK. 

 

 
 

 
Deleting A Company Record 
 
If you need to delete a company, any divisions under it will be promoted to a company unless you delete 
the division(s) first. You will not receive a warning that the company that you are deleting has divisions. 
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Groups Overview 
Grouping records is another way for you to be able to categorize and find contacts. You have learned how to 
use the lookup command to find contacts. The limitation to using the lookup command is that all of the records 
have to have the same information in the same field. You could think of the group feature as a free form way 
to classify or categorize records, because they do not have to have any data in common. You can create as 
many groups as you need. 
 
If you wanted to group certain contacts together because they are all involved in the same project, you could 
create a group. Contacts can be in more than one group. Grouping contacts helps you find and organize them 
quickly. The main benefit to creating groups over creating lookups, is that the group information is saved. 
 
The top right of the Group Detail view displays the group name and description of the group that is 
highlighted. The bottom right section displays different information depending on which tab is selected.  
For example, the Group Info tab shows information about when the group was created, whether or not the 
group is private and who created it. The names on the Contacts tab are the people that are in the group. 
Figure 3-21 shows the Group toolbar for both group views. Table 3-5 explains the buttons on the toolbar. 
 

 
 
Figure 3-21 Group toolbar 
 

 Button  Description  
1 Opens the Group Detail view. 
2 Opens the Group List view. 
3 Saves the record. (3) 
4 Opens the Print dialog box. 
5 Opens a new group record. 
6 Opens a new subgroup record. 
7 Add or remove a contact. 
8 Add a note for the group or contact record. 
9 Schedule a telephone call. 
10 Schedule a meeting. 
11 Schedule a To-Do. 
12 Creates an opportunity for the group. (3) 
13 Attach a file to a group record. 
14 Displays the members of the group in the Contact List view.
15 Compose and send an email. 
16 Export the group list to Excel. (4) 
17 Opens the Help system. 

 
Table 3-5 Group toolbar buttons explained 
 

 (3) This option is only available from the Group Detail view. 
 (4) This option is only available from the Group List view. 

 

Good Groups And Not So Good Groups 
These are the types of groups that you can create. An example of a not so good group would be a group that 
contained contacts in the same state. This is not a good use of a group because you can create a lookup by 
state to accomplish this. 
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An example of a good group would be a group that contained contacts that attended an insurance seminar that 
you were a guest speaker at. This is a good group because there is no existing field that you could create a 
lookup on to find these contacts. 
 

The Groups Tree 
The Groups tree is on the left of the Group Detail view. At the top of the Groups tree, the number of groups 
and subgroups in the database are displayed as shown in Figure 3-22.  
 
A plus sign in front of a group means that there is at least one group or subgroup below it. The Employees 
group shown in Figure 3-22 has two subgroups, International Employees and USA Employees. The 
International Employees group has two subgroups, AsiaPac Employees and European Employees. 
 
If you click on a group in the tree, you will see the subgroups in the list on the right, as shown in Figure 3-22. 
 

 

 
The UP button illustrated in Figure 3-22 is active if the group or subgroup that is selected is part of a 
larger group. Clicking this button will move up the hierarchy, one level at a time. This button is also on 
the Company Detail view. If you double-click on any subgroup shown, the detail record for the subgroup 
will be displayed. 
 

 
 
Figure 3-22 Groups and Subgroups illustrated 
 

View Groups/Companies Button  
This button is available on the Contacts, 
Groups and Company Detail views. It will 
open the dialog box shown in Figure 3-23. 
It provides a quick way to view the 
groups and companies that are in the 
database. Select the option in the VIEW 
drop-down list for the type of view  
(group or company) that you want to see. 
The matching records will be displayed at 
the bottom of the dialog box. 
 
If you click OK, the contacts displayed are 
from the view that you selected.  

 
Figure 3-23 View Groups/Companies dialog box 
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Group List View 
This view provides an easy way to view groups 
and subgroups as shown in Figure 3-24. The icon 
in the first column indicates that the group has 
subgroups. If you do not want to see the 
subgroups, clear the INCLUDE SUBGROUPS option. 
 

 
 
Figure 3-24 Group List view 
 

Exercise 3.13: How To Create A Group 
1. Click the GROUPS button in the Navigation bar.  

 
2. Click the NEW GROUP button on the toolbar. You should see a new group record at the top on the right. 

 

 

 
You can also right-click on a blank space in the Groups tree and select NEW GROUP. 
 

3. Type Potential Customer in the Group field. 
 

4. Press the Tab key and type This group contains contacts that are interested in 
the next version of the workbook in the Description field.  

 

 

 
The Description field can have up to 128 characters. 
 

5. Your group should look like the one shown in Figure 3-25. Click Save. Notice that the HIERARCHY field 
was filled in and that the group appears on the left side of the window. 
 

 

 
 
Figure 3-25 New group 
 

Adding Contacts To A Group 
There are several ways that you can add contacts to a group, as discussed below: 
 
  You can scroll through the entire list of contacts in the Contact List view and select the contacts that 

you want, one by one and add them to a group. This is known as a STATIC group. The contacts stay 
in the group until you remove them. 

  If possible, you can use the lookup command to find the records that you want to add to a group. 
  Select an existing group and add contacts from the existing group to the new group. 
  Contacts can automatically be added to a group if they meet the criteria of the query. This is known 

as a DYNAMIC group because contacts are added and removed based on whether or not they meet 
the criteria. There is no intervention on your part after creating the query. An example is a group for 
contacts that have the title Sales Rep. Contacts added to the database that have this title would 
automatically be added to the group. Any contact in the group whose title changes from Sales Rep 
would automatically be removed from the group. You will learn how to create this type of group in 
Lesson 8. 
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The benefit of using the last three options discussed above to add contacts to a group is that you do not have 
to scroll through all of the records in the database. You can add a contact to as many groups as needed. 
 

 

 
When you add a contact that has a note to a group, the contacts notes are displayed on the Groups Note 
tab, unless the note is marked private. You will see the private note in the group, but other users will 
not. 
 

Exercise 3.14: How To Add Contacts One By One To A Group 
The contacts that you add to the group in this exercise are static. 
 

1. Select the group that you want to add contacts to. In this exercise select the Potential Customer group. 
 

2. Click the ADD/REMOVE CONTACTS TO GROUP button on the toolbar or the ADD/REMOVE CONTACTS button in 
the tab section of the window. You will see the Add/Remove Contacts dialog box shown earlier in  
Figure 3-6. Click the Contacts button. 
 

3. Click on the contact Ashley Allan, then press and hold down the CTRL key and click on the following 
names: Bruce Baker, Sarah Baker and Kirby York. 
 

4. Click the ADD  button. The four contacts that you selected should be visible in the SELECTED CONTACTS list 
as shown in Figure 3-26. 
 

 
 

 
 
Figure 3-26 Contacts added to the group 
 

The options in the SELECT FROM drop-down 
list and the drop-down list to the right, let 
you narrow or widen the number of names 
that appear in the Contacts to select from 
list. If you select the GROUPS option from 
the drop-down list and the Hot 
Opportunities group, you will see the 
contacts shown on the left of Figure 3-27. 
 
If the database has a lot of names and you 
do not want to scroll through the list, you 
can type the name that you want to add to 
the group in the LOOK FOR field. 

 
 
Figure 3-27 Contacts from an existing group 
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 If you scroll through the list of names on the left, you will see that the names that you added to the 
group are grayed out. This lets you know that the contact is already a member of the current group or 
has been selected to be a member of the current group. 
 

5. Click OK. You should see the contacts in the STATIC MEMBERS section of the Add/Remove Contacts dialog 
box. Click OK. The contacts will now be added to the Potential Customer group that you created. You will 
see the contacts at the bottom of the Contacts tab, as shown in Figure 3-28. 
 

 

 
 
Figure 3-28 Contacts added to the group 

 

 

 
To add a contact to a group, you can right-click on a contact record on either contact view and select 
ADD CONTACT TO GROUP. 
 

Looking Up Groups 
Looking up groups is similar to looking up companies. Lookup ⇒ Groups ⇒ Select an option, will display the 
same dialog box that you used in Lesson 2 to look up contacts. The differences are the same as the differences 
for companies.  
 

Exercise 3.15: Finding Group Records 
Earlier in this lesson you learned how to find (look up) all of the contacts that were associated with a company. 
Looking up contacts that are in the same group is basically the same process. In this exercise you will create a 
look up for groups that are missing data in the primary address field. 
 

1. Lookup ⇒ Groups ⇒ Other Fields. 
 

2. Open the Look in this field drop-down list and select the Address 1 field, then select the EMPTY FIELD 
option, as shown in Figure 3-29. Click OK. 
 

 

 
 
Figure 3-29 Lookup Groups dialog box 
 

You will see the groups that do not have any information in the Address 1 field. If you double-click on any 
group in the Group List view and then click on the Address tab, you will see that the Address 1 field is empty. 
 

Exercise 3.16: How To Rename A Group 
The steps below will show you how to rename a group. 
 

1. Click on the group that you want to rename in the Groups tree, as shown earlier in Figure 3-22.  
In this exercise click on the Potential Customer group. 
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2. Type in the new group name. Type the word Book after the word POTENTIAL in the Group field,  
then click the Save button. The group will be renamed. 

 

 

 
The reason that I click the Save button is because it refreshes the view. If you clicked on another group 
in the tree and then come back to the group you changed, you would see that the group was renamed. 
 

Exercise 3.17: Add Contacts To An Existing Group 
In this exercise you will find contacts in Arizona and add them to the Potential Book Customer group. 
 

Create The Lookup And Add The Contacts To The Group 
1. Create a lookup to find all contacts in Arizona. There should be 15 records in the Contact List view. 

 
2. Select (highlight) the 15 records, then right-click on the highlighted records and select  

ADD CONTACTS TO GROUP as shown in Figure 3-30. 
 

 

 
 
Figure 3-30 Option to add the contacts to a group illustrated 

 

 

 
If you do not want to right-click on the records, use Groups ⇒ Group Membership ⇒ Add Selected to 
group. 

  
3. Click on the Potential Book Customer group as shown in Figure 3-31, then click OK. 

 
 

 
 
Figure 3-31 Group selected to add contacts to 
 

View The Contacts In The Group 
1. Click the Groups button on the Navigation bar, then click on the Potential Book Customer group in the 

Groups tree. 
 

2. Click on the Contacts tab. You should see the 15 contacts that you just added, plus the contacts that you 
added in a prior exercise. Click the Save button. 
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Exercise 3.18: Use The Lookup Command To Add Contacts To A Group 
You can use this option when you have several records that have something in common that you want to add 
to the same group. In this exercise you will create a lookup to find all contacts that have the Sales 
Representative title. After that, you will create a group and add the contacts to a group. 
 

Create The Lookup And The Group 
1. Create a lookup that finds all contacts that have Sales Representative as the title. 

 
2. Groups ⇒ New Group. 

 
3. Type Sales Reps in the Group field, then type This group contains all of the sales 

reps. in the Description field. 
 

4. Click the Add/Remove Contacts button, then click the Contacts button. 
 

5. Select the CURRENT LOOKUP option from the drop-down list. You should only see the contacts from the 
lookup that you created, in the list of names on the left side of the dialog box, as shown in Figure 3-32. 
 

 

 
 
Figure 3-32 Contacts from current look up 
 

6. Click the ADD ALL>> button. All of the contacts should be in the list on the right side of the dialog box. 
Click OK twice to close both dialog boxes.  
 

7. In the Group Detail view click on the Sales Reps group in the Groups tree. On the Contacts tab you will 
see the contacts that are in the group.  
 

How To View The Groups A Contact Is A Member Of 
1. Click on the link for Emily Dunn. 

 
2. On the Groups/Companies tab in the Contact Detail view, you will see that this contact is a member of 

the Sales Rep group that you just created and the Potential Book Customer group that you created 
earlier in this lesson. 
 

Exercise 3.19: How To Manage Group Notes And Attachments 
The Notes tab on the Group Detail view allows you to enter notes for the group, just like you can enter notes 
for a contact. If you create a note for the group, you only have to type it in once and it will be associated with 
all contacts in the group. You can also assign a contacts note to a group. There are several ways to create a 
note for a group. 
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How To Create A Group Note And Attach A File To The Group Note 
In addition to adding a note to a group, you can attach files like charts, spreadsheets or sales literature to a 
group. Doing this allows you to keep all of the attachments for the group in one place. 
 

1. Click the Groups button, then click on the Potential Book Customer group. 
 

2. On the Notes tab, click the INSERT NOTE button. You should see the Potential Book Customer group 
name in the Group/Company field on the Insert Note dialog box. 
 

3. Type These contacts have requested a book catalog. in the REGARDING field. 
 

4. Select the text that you just typed and change the font to Comic Sans MS, then change the font size  
to 12. Change the color to red. The color option is to the right of the Font Size drop-down list.  
Leave the dialog box open to complete the next part of the exercise. 
 

How To Attach A File To A Group 
In Lesson 2 you attached a file to a contact record. Attaching a file to a group record is the same process. 
 

1. Click the ATTACH button on the Insert Note dialog box. 
 

2. Double-click on the L2 Attach file. The note should look like the one shown in Figure 3-33. Click OK. 
 

 

 
 
Figure 3-33 Group note  
 

View The Group Notes And Attachments 
1. On the Notes tab, open the SHOW FOR drop-down list and select Group. The entry should be the same 

one shown above in Figure 3-33. 
 

2. Click on the Attachment icon for the note. The attached file will open. Close the attached file. 
 

Exercise 3.20: Assign A Contact Note To A Group And Individual Contacts  
In this exercise you will complete the following tasks: 
 
  Create two notes for a contact that is in a group. 
  Associate one of the notes to contacts in the group that the contact in the task above is a member of 

and to one contact that is not in the group. 
  Associate the second note to a group that the contact in the first task is not a member of. 

 

Add The Contact To Another Group 
1. On the Contacts tab, right-click on the contact Sarah Baker in the Potential Book Customer group and 

select Group Membership ⇒ Add Selected to Group. 
 

2. Select the Prospects - Hot Opportunities group, then click the Add button. The contact should be a 
member of two groups, as shown on the right of Figure 3-34. Click OK. 
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Figure 3-34 Add Contact to Groups/Companies dialog box 
 

Create The Notes 
In this part of the exercise you will create the notes for Sarah Baker. 
 

1. Open the Contact Detail view for the contact Sarah Baker. (Hint: If you are in the Group Detail view, 
click on the contacts name on the Contacts tab). 
 

2. Click on the Notes tab in the Contact Detail view and create the notes in Table 3-6. 
  

Note Regarding Field  Formatting  
1 This is the first contact note for S. 

Baker. It will be applied to individual 
contacts in 2 groups and 1 contact that 
is not in a group. 

Change the font size to 10 and 
the text color to green and 
bold. 

2  This is the second contact note for S. 
Baker. It will be applied to the group 
via the Insert Note dialog box.  

Change the color of the text to 
purple, bold and italic. (5) 

 
Table 3-6 Notes to create for Sarah Baker 
 

 (5) Click the button at the end of the Group/Company field on the Insert Note dialog box. Click OK to 
share the note as shown in Figure 3-35. Select the Potential Book Customer group to add to the 
note. You should have the options shown in Figure 3-36. 
 

 

 
 
Figure 3-35 Sharing a public note message 
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Figure 3-36 Note associated to a group 
 

Associate The Notes 
1. Locate the first note that you created in Table 3-6 for Sarah Baker in either the Contact or Group Detail 

view, then double-click on the note. 
 

2. Click the CONTACT button on the Edit Note dialog box and select the contact George Bailey. 
 

3. Open the SELECT FROM drop-down list and select Groups, then select the Sales Reps group from the next 
drop-down list. You will see the contacts for the group at the bottom of the dialog box. Add Bettie James 
to the contact list. 
 

4. Select the Prospects group. Add the contacts Mary Bailey and Kirby York. You should have the contacts 
selected that are shown in Figure 3-37. 
 

 

 
 
Figure 3-37 Group contacts 
 

5. Click OK twice to close both dialog boxes. When you see the dialog box shown in Figure 3-38 select the 
first option and click OK. 
 

 

 
 
Figure 3-38 Edit shared note options 

 

 

 
Editing A Shared Note 
 
After creating a note, you may need to update the information in the note. When you modify a note that 
is shared with groups or contacts, you will see the dialog box shown above in Figure 3-38. Select the 
option for how you want the changes to the note to be applied. 
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View The Notes 
1. Create a lookup by last name. Search for Bailey. You will see three contacts. Mary and George Bailey will 

have the first note in Table 3-6 above (in green). Peter Bailey does not. This is correct. 
 

2. The note should also be available in the Prospects group. If you do not see the note select  
GROUP CONTACTS in the Show for drop-down list. 
 

3. View the Potential Book Customer group notes. You will see the second note that you created in  
Table 3-6 above. You will also see the first note because it was created by Chris Huffman (aka you) who 
is a member of the Potential Customer group. 
 

Show For Drop-Down List Options 
The options in the SHOW FOR drop-down list 
shown in Figure 3-39 are available on the 
notes, history, activities and opportunities 
tabs in the Group Detail view. The options let 
you filter the entries that will be displayed. 
 
 

 
 
Figure 3-39 Show For drop-down list options 
 

ALL will display both group and group contact entries. 
GROUP will display entries that are created at the group level. 
GROUP CONTACTS will display entries that are associated with a contact in the group. They are created at the 
contact level like the one that you created earlier in Exercise 3.20.  
The difference between Group and Group Contacts entries are the level that they are created at.  
 

 
 

 
Group level notes cannot be viewed on the Notes tab in the Contact Detail view. To know if there is a 
group note for the contact, click on the Groups/Companies tab on the Contact Detail view, then  
double-click on the group and click on the Notes tab in the Group Detail view. 
 

If the note is long, you will not see all of it on the Notes tab. If you look to the far right of the window,  
you should see a shaded area. This is the Preview area.  
 
If you click on a note, you will see the note on the right side of the window. You can resize the Preview area  
by placing the mouse pointer in the position illustrated in Figure 3-40 and drag the mouse pointer in the 
direction that you want to resize the window to. 
 
If you do not want to have 
the Preview area visible, you 
can hide it by clicking on the 
Options button and clearing 
the SHOW PREVIEW option. 
You can do this on any 
Notes tab. 
 

 
Figure 3-40 Preview area illustrated 
 

Exercise 3.21: How To Save The Result Of A Lookup As A Group Or Company 
If you create a lookup that you will use over and over, you can save it as a Group or Company by following the 
steps below. The number of records in this type of group or company can change. If the value in the field that 
the lookup is using changes and now meets the criteria, the contact record will automatically be added to the 
group or company. If the value in a contact record changes and no longer meets the lookup criteria, it will 
automatically be removed from the group or company. 
 

1. Create an Email Address lookup for contacts that do not have an email address.  
 

2. Lookup ⇒ Groups ⇒ Save Lookup as Group. 
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3. Type My Group Lookup No Email as the group name, then View ⇒ Refresh. 
 

4. Lookup ⇒ Companies ⇒ Save Lookup as Company. 
 

5. Type My Company Lookup No Email as the company name, then View ⇒ Refresh. If you view 
the records under the company and group that you just created, you will see that both have the same 
records.  
 

Subgroups 
A subgroup is usually a subset of the contacts in the group. In the previous exercise you created a group that 
contains contacts that do not have an email address. If you wanted to further categorize the contacts by 
company, title, state, status or just about anything that you can think of, you can create a subgroup. 
Subgroups can be 15 levels deep, meaning subgroups can have subgroups. Subgroups are similar to divisions 
that companies have. 
 

Exercise 3.22: Creating Subgroups 
In this exercise you will create two subgroups for the My Group Lookup No Email group; one for sales reps and 
one for title. 
 

1. In the Group Detail view, right-click on the My Group Lookup No Email group and select NEW SUBGROUP. 
 

2. Type Sales Reps No Email in the Group field, then type This subgroup contains sales 
reps that do not have an email address in the Description field. 
 

3. Click on the My Group Lookup No Email group in the Groups tree. You should see the subgroup. 
 

4. Create another subgroup under the My Group Lookup No Email group. Use No Title as the name.  
Type These contacts do not have a title in the Description field.  
 

Exercise 3.23: Moving (Copying) Contact Records Between Groups And Subgroups 
After subgroups are created, it is a good idea to move the appropriate records from the group to a subgroup. 
In this exercise you will move contacts that have the Sales Rep title to the corresponding subgroup and 
contacts that do not have a title to a different subgroup. There are two ways to move contact records as 
discussed below.  
 
  Move the contacts manually. 
  Use a query. You will learn how to do this in Lesson 8. 

 
Keep in mind that the contact records are not physically removed from the group and placed in the subgroup. 
The contact records are copied. This means that contact records at the group level can also be in a subgroup. 
There are three ways to avoid this if you think it will drive you crazy to see the same contacts in the group and 
subgroup. This is one of the items on my ACT! wish list that I would like to see improved. I think it would be 
easier if we could move contacts between groups and subgroups. 
 
  Do not create any subgroups. Only create groups. 
  Use the Add/Remove Contacts dialog box to remove the contacts from the group. 
  Do not add records to a group that you really only want to see in a subgroup. 

 

Moving Records Manually 
1. Click on the My Group Lookup No Email group, then click on the Contacts tab. 

 
2. Sort the contacts by the Title field. The contacts that do not have a title should be at the top of the list. 
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3. Click in the row of the first contact without a title. Press and hold down the Shift key, then click in the 
row of the last contact record that does not have a title. 
 

4. Right-click on the highlighted records and select Group Membership ⇒ Add Selected to Group. 
 

5. Select the NO TITLE subgroup that you created in the previous exercise, then click OK. 
 

6. Select all of the contacts that have the Sales Representative title in the My Group Lookup No Email group 
and add them to Sales Reps No Email subgroup. 
 

7. If you click on the Sales Reps No Email subgroup you will see the contacts that you added as shown in 
Figure 3-41. 
 

 

 
 
Figure 3-41 Contacts in a subgroup 
 

Deleting Groups Or Subgroups 
You may have a need to delete a group or a subgroup. When you delete a group or subgroup, the contacts, 
their notes and attachments are not deleted. The groups notes, history records and attachments are deleted. 
Subgroups of the group that will be deleted are not deleted. If you need to delete a group or subgroup, you 
can follow the steps below. For now, you can read this section because you do not need to delete any group or 
subgroup. 
 

How To Delete A Group  
1. Right-click on the group in the Group Detail or Group List view and select Delete. 

 
2. Click Yes when prompted to delete the current group. 

 

How To Delete A Subgroup  
1. Right-click on the subgroup in the Group Detail or Group List view and select Delete. 

 
2. Click Yes when prompted to permanently delete the current subgroup. 

 

Removing Contacts From Companies Or Groups 
There may be times when you need to remove contacts from a company, division, group or subgroup.  
An example would be if the contact leaves the company. If this is the case, you can follow the steps below to 
remove contacts that are not linked to a company, division or group record.  
 

1. Right-click on the company, division or group that has contacts that you want to remove in the tree and 
select Company Membership ⇒ Add/Remove Contacts or Group Membership ⇒ Add/Remove Contacts.  
 

2. Click the Contacts button on the Add/Remove Contacts dialog box.  
 

3. Select the names that you want to remove in the SELECTED CONTACTS list, then click the Remove button. 
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4. Once you have removed the contact records, click OK twice to close both dialog boxes. 
 

Removing Links Between Contact And Company Records 
If a contact is linked on the Company (name) field, it cannot be changed until you remove the link. Earlier in 
this lesson you learned that contact notes and history records that appear under the company record are not 
automatically removed. Removing the link between the contact and company is how the contact records 
remain under the company record. 
 

1. Open the contact record (in the Contact Detail view) that you want to remove to company link from. 
 

2. Click the button at the end of the Company field. You will see the message shown in Figure 3-42.  
Click OK. The link will be removed and the Company name will no longer be linked. 
 

 

 
 
Figure 3-42 Disable link message 
 

Converting A Group To A Company 
Groups and subgroups can be converted to a company. If the group or subgroup that you convert has 
subgroups, the subgroups are not converted. They move up the hierarchy and quite possibly become a group.  
Contacts that are in the group or subgroup become members of the company. 
 
One reason that you may convert a group to a company is because the contacts in the group have the need to 
use some of the features that a company record has. In this exercise you will convert the My Group Lookup No 
Email group to a company. 

 
 

 
Once you convert a group to a company, it cannot be converted back. 
 

Exercise 3.24: Using The Convert Groups To Companies Wizard 
1. In the Group Detail view, right-click on the My Group Lookup No Email group and select Convert to 

Company. 
 

 

 
Groups ⇒ Convert To Company, will also open the wizard shown in Figure 3-43. 
 

2. Click Next on the first screen of the wizard. You will see the screen shown in Figure 3-43. Click Next. 
 

The SELECT GROUPS screen shown in Figure 3-43 lets you select the group(s) that will be converted to a 
company. Because you selected the group before opening the wizard, the group is already selected and in the 
SELECTED GROUPS list, ready to be converted to a company. 
 
If the group has subgroups that you also want to convert, check the INCLUDE SUBGROUPS option. 
 
The MAP FIELDS screen shown in Figure 3-44 lets you select the field in the company record that data from a 
field in the group record will be moved to. 
 
If you need to select a different company field, click in the company field that needs to be changed and select 
the field that you need from the drop-down list as shown in Figure 3-44. 
 
If you modified the group view and added fields to it, you will not see a corresponding field in the list of 
company fields. You will have to modify the company view also. You will learn how to modify layouts in  
Lesson 10. 
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Figure 3-43 Select Groups screen 
 

 
 
Figure 3-44 Map Fields screen 
 

3. The fields are mapped correctly. Click Next on the Map Fields screen. 
 

 
 

The screen shown in Figure 3-45 displays 
the group(s) that will be converted. 
 
 
 

 
 
Figure 3-45 Groups to be converted screen 
 

4. Click Next on the screen shown above in Figure 3-45. The Convert Groups to Companies screen lets you 
know when the group has been converted. 
 

5. Click Next after the group has been converted. Click Finish on the last screen of the wizard. 
 

The group record has been removed. If you look in the Company Detail view you will see the My Company 
Lookup No Email company. If you need to change the company name you can. 
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